CS 10:

Problem solving via Object Oriented
Programming

Welcome to the class!



Today main learning goals

1. Getto know each other

2. Align expectations about CS10, outcomes, teaching
methods/tools, coursework, collaboration

3. Describe the pillars of Object-Oriented Programming
(OOP)

4. ldentify some main differences between Python and Java
5. Program hello world

6. Use variables and arrays



» 1. You, the teaching team, and this
course

2. Object Oriented Programming (OOP)

3. Java intro
1. Hello world
2. Variables
3. Arrays
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Your background

 How did you satisfy the pre-reqgs?
e CS1
* ENGS 20
* AP exam
e Other

 What’s your future plan?
* CS majors?
* Minors?
* Not sure?

 How many of you programmed in Java before?



Primary objective of the course

Reinforce the foundational perspective and skills needed
to develop computational solutions to real interesting problems.

CS87/187 Rendering algorithms

CS83/183 Computer Vision

CS81/181 Robotics

And many others, including Artificial intelligence, Machine learning,
Bioinformatics, ...
https://web.cs.dartmouth.edu/undergraduate/undergraduate-courses 7
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Main learning outcomes:

Problem solving via Object Oriented Programming
(not simply how to program in Java)

Learn by solving real
problems, implementing
and debugging!
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import org.bytedeco.opencv.opencv_core.*;

°
import static org.bytedeco.opencv.global.opencv_core.*; :

%0 (1)

import static org.bytedeco.opencv.global.opencv_imgproc.*; &

* Class to color correct an image.
*/

public class ColorCorrection {
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while S is not empty do
v = S.pop()
if v is not labeled as discovered then
label v as discovered
for all edges from v to w in G.adjacentEdges(v) do esse 8
S.push(w)



Learning resources: multimodal

Lectures for covering concepts

e 12 time slot MWF 12:50-1:55 pm EDT (recording
posted afterwards)
X Tu 1:20-2:10pm EDT (see on Canvas if used)

* Feel free to ask questions

Recitation section meetings for hands-on:
* 1 hour/week (starting this week)

CS 10: Problem Solving via Object Oriented Programming
Spring 2024

Website for notes, slides, and assignment

Note! The sylabus and the schedule can be subfect toa d] stment 2 th er progresses.
es lis

T R instructions (https://www.cs.dartmouth.edu/cs10/)

Welcome to COSC 10!

xka to davelon sils i soving computatonal problams I partica, topcs you willeam iclude )
ity mpose problemé), dat 25 (how t6 eficiently organize data), and algorithms y a u S
ekly e
lems.
* Schedule

d programming assignmi a following objected-

n dav, by Mi ichael H. Goldwasser. Available
e uch cheaper). e tertbams uired; we'l provide all of the invorm atio nynul
 dive on some subjects 0 see what professional Java code o

Textbook for additional examples and explanations: Data
Structures & Algorithms in Java, 6th ed, by Goodrich, Tamassia,
and Goldwasser


https://www.cs.dartmouth.edu/cs10/

Learning resources: assessment

To assess your learning, you will:

1. Solve recitation section meeting programming 8 recitation section meeting
drills and short assignments by writing relatively programming drills
small code snippets to consolidate the concepts 0% | 1+10short assignments
learned every week in class.

2. Solve problem sets by writing programs to apply
the concepts learned in class to real-world
problems.

* You can find one problem set collaborator

3. Answer exam questions.

6 Problem
sets

Exams:
* 2 midterms (each 20%)

Please see the details on the syllabus (late policy, * 1 cumulative final (20%)
grade, extra credit, ...)

https://www.cs.dartmouth.edu/cs10/#coursework

Please reach out if you’re falling behind — we’re happy
to help

10
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Learning resources: how to get help

*  Few channels to simplify the use
*  #classes-discussion: for questions and discussions on the concepts covered
in the class.

» SIaCk e #help-assignments: for questions and discussions on the assignments.

Help each other (please remember the honor code; if in doubt, ask)
 Don’t post solution!
(access via * The teaching team will typically respond within 24 hours
Canvas) e Use the public channels first
* Don’t hesitate to ping in case we missed your message
*  Anonymous messages are possible with /anonymous command
e Let’s build an inclusive community!

Office hours (~3 hours/week each member of the teaching team)
* Profs. and TAs
' * Each of you will have a reference TA to have a long-term
support
* ECSC building
* Zoom as needed

11




Learning resources: other tools used

Canvas (https://canvas.dartmouth.edu/courses/65523)

il « Course anhouncements
Nav * Calendar with office hours
CANVAS * Section assighnments

e Link to Slack

* Link to Gradescope
* Link to Panopto
* Record of assignment and current overall grading

S

Recordings on Panopto folder (access through Canvas)

III Submissions via Gradescope (access through Canvas) for
0 consistent grading

gradescope

If you have any problem, please let us know

12
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Tentative schedule

Please keep an eye as everything will be posted and updated here

wl

w2
w3

w4
w5
wb6

w7/

w8

w9

w10

Day1
Day2

Day3
Day4
Day5
Day6
Day7
Day8

Day9

Day10
Day11
Day12
Day13
Day14

Day15
Day16
Day17
Day18
Day19
Day20

Day21
Day22

Day23
Day24

Mar 25
Mar 27

Mar 29
Apr 1
Apr 3
Apr 5
Apr 8
Apr 10
Apr 12
Apr 15
Apr 17
Apr 19
Apr 22
Apr 24
Apr 26
Apr 29
May 1
May 3
May 6
May 8
May 10
May 13

May 15
May 17

May 20
May 22
May 24
May 27
May 29
Jun 3

intro
encapsulation

inheritance
graphics
abstraction

lists

lists 2
hierarchies
midterm 1
hierarchies 2
hierarchies 3
info retrieval
hashing

keeping order
prioritizing
midterm 2
relationships
graph traversal
shortest paths
pattern matching
pattern recognition

(no class, video)
web services

(no class, video)
client/server

(no class, video)
synchronization

producer/consumer
string finding
review

Memorial day
review

final exam

class goal, syllabus, Java basics
classes, instance variables, contructors, overloading

base classes, subclasses, overriding
buffered images, video

abstract data types, asymptotic notation
linked list implementation

growing array implementation

trees and recursion

6:00pm - 8:00pm Room TBA

binary search trees

balance, 2-3-4 trees, red/black trees
maps, sets

hash functions, tables

stacks, queues

priority queues, heaps

6:00pm - 8:00pm Room TBA

graphs

breadth- and depth-first search
Dijkstra's algorithm, A* search

finite automata

hidden Markov models

acronym soup (URL, REST, XML, GUI)

sockets, threads
synchronized blocks, monitors, semaphores

streams
Boyer-Moore, tries, suffix trees
Final recap

ask questions about the final
3:00pm - 6:00pm Cummings 100

7.1

3.2

7.2,3.1.1, 4-4.3, 7.4
8

11.1
Ch11.2, 11.5, 11.6
10.1

10.2

6

9.1-9.4

14.1, 14.2
14.3
14.6

Java tutorials
Java tutorials
Java tutorials

Java tutorials
Ch13.2, 13.3

https://www.cs.dartmouth.edu/cs10/schedule.html

SA-0
SA-1

SA-2
SA-3
PS-1
SA-4

SA-5
SA-6
SA-7
SA-8
PS-3

SA-9
PS-4

SA-10 & PS-
6

SA-0 (Survey
due Mar 25,
11:59pm)
SA-1

SA-2

SA-3

SA-4
PS-1

SA-5 & PS-2
SA-6
SA-7
SA-8

PS-3
SA-9

PS-4

PS-5 & SA-10

PS-6

13
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Short Assignment (SA-0) out, complete

survey before 11:59pm today

 Find it on Gradescope (via Canvas)

 Take course survey to understand your background and
assign you to a section

* Set up development environment (IntelliJ IDEA) and get
Hello World running

* Instructions and screen shots provided on website
https://cs.dartmouth.edu/cs10/software.html

* Create your first Java class

 Read and acknowledge course policies and honor code

* If you have any questions or comments, please feel free to leave
a comment
e Complete survey ASAP before 11:59pm today (or risk
getting assigned to inconvenient section time!)

14
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Learning resources: advice

Successful learning in the class is typically
associated with

* Reading the material recommended

* Actively Participating in the class

e Starting all assignments as soon as they are out
* Reaching out for help immediately when stuck

We will succeed if we work together

* Please talk to us if you are running behind or if
you have any guestions/comments

15



1. You, me, and this course
» 2. Object Oriented Programming (OOP)

3. Java intro
1. Hello world
2. Variables

3. Arrays

16



OOP four main pillars for robust, adaptable

and reusable code

Encapsulation Polymorphism

J

J

T 7 A B 4 A I 4
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e
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Encapsulation

Encapsulation = Data + Code

Data Code
Variablesj \Methods

Class = Variables + Methods

vw.btechsmartclass.com

19



Inheritance

Person

name,
designation

learn(),
walk(), eat()

Programmer Dancer Singer
name, name, name, .
designation, designation, designation,
companyName groupName bandName
learn(), learn(), learn(),
walk(), walk(), walk(),
eat(), eat(), gat( )
coding() dancing() singing(),

playGitar()

‘www.btechsmartclass.com

reduces code redundancy 20



Polymorphism

learn()

Same method

with
Programmer different
learn() implementations Dancer

with coding languages learn()

with dancing steps

Singer

learn()
with tunes, music, songs

www.btechsmartclass.com 2 1



Why is OOP in general so popular?

Well-organized: Relative data and functions
are grouped in the same object.

Code reusability: Abstraction allows you to
reuse code throughout a project.

Testing and debugging: The self-contained
nature of OOP can make testing and
debugging easier.

Promotes collaboration among
developers: The use of classes, objects, and

well-defined interfaces facilitates teamwork.

Improves code readability and
documentation: Makes it easier for
developers to understand and contribute to
the codebase

) l )
2 . 7

|
Polymorphism

https://learningcode.tech.blog/2022/07/08/0ops-pillars/
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OOQP is popular, especially in large

organizations

Top languages used in large organizations
- * Each of the
most
common
languages is
object
oriented

Java

C++

G * Javais

. particularly
popular in
——————————— |arge

organizations

Python

0 10 20 30 40 50 60 70
Percentage of organizations using language

23
Source: https://www.cloudfoundry.org/wp-content/uploads/Developer-Language-Report_FINAL.pdf (Javascript omitted)



1. You, me, and this course

2. Object Oriented Programming (OOP)

» 3. Javaintro

1. Hello world
2. Variables
3. Arrays

24



Interpreted vs. compiled language

-4in

o et iana lana X

: Source Code
N _| Print Hello World

-

High Level Language code

Interpreter

Hello World!

Run

25




Interpreted vs. compiled language

ir A : x executable machine code

i i oL 1 .

4 -ir st : =

] -] ] inpe——— ' & 0010010100110

1111 source Code Compiler 100101010101

7171 1 _| Print Hello World 101010101
- 10101010

Run

High Level Language code

Hello World!




1. You, me, and this course

2. Object Oriented Programming (OOP)

3. Javaintro

» 1. Hello world
2. Variables

3. Arrays

27



We can flesh out the boilerplate code to

print “Hello World!” to the console

Python Java
1 nnn /.+:¢|
. @ Standard 'Hello World' first program
2 Standard 'Hello World' first program *
3 * @author Everyone who has ever written about programming and Tim Pierson too,
4 @author Everyone who has ever written about programming * Dartmouth CS 10, Fall 2018
5 nun */
6 . . . public class HelloWorld {
7 print("Hello World!™) public static void main(String[] args) {

System.out.println("Hello World!");

28



1. You, me, and this course

2. Object Oriented Programming (OOP)

3. Java intro
1. Hello world

» 2. Variables
3. Arrays

29



In Python we declare variables but do not

say what type of data they hold

Python example python_variables0.py
Code

print(x)

Output

S python3 python_variables0.py

Traceback (most recent call last):
File "PythonVariables.py", line 2, in <module>
print(x)
NameError: name ‘X' is not defined

30



In Python we declare variables but do not

say what type of data they hold

Python example python_variables01.py
Code
X =5 Note: we didn’t tell Python what type of data x
print(x) holds, just its value

Python guesses x is an integer based on the
value assigned (called dynamic or duck typing)

Output
S python3 python_variables01.py

5

31



Python’s type function tells us what kind of

data the variable holds

Python example python_variables02.py
Code

X =5

print(x)
print(type(x))

Output

S python3 python_variables02.py

5
<class 'int'>

32



In Python a variable’s data type can change

Python example python_variables03.py
Code

X =5

print(x)
print(type(x))

x = "Hello World"
print(x)
print(type(x))

Output

S python3 python_variables03.py
5

<class 'int'>
Hello World
<class 'str'>

33



In Java, we explicitly say what type of data

a variable holds (and can’t change it later!)

Common primitive types

Type Description Size FEJES
int Integer values (no decimal | 32 bits (4 bytes) -104,...1,2,3...107,...5032
component)
double | Double precision floating 64 bits (8 bytes) -123.45, 1.6
point (has decimal
component)
boolean | true or false 1 bit true, false
char Characters 16 bits (2 bytes for a’’b’,.. 7
Unicode)

Note: String are objects, not primitives
We will discuss objects next class
34



In Java, we explicitly say what type of data

a variable holds (and can’t change it!)

JavaVariablesO0.java

Code

public class JavaVariablesO {
public static void main(String[] args) {
int x;
System.out.printin("x = "+x);

}
}

Output

35



Java does not initialize local variables

JavaVariablesO0.java
Code

public class JavaVariablesO {
public static void main(String[] args) {
int x;
System.out.printin("x = "+x);
}
}

Output

$ javac JavaVariables@.java
JavaVariables@.java:4: error: variable x might not have been initialized
System.out.println("x = "+x);

N

1 error

36



Java tells us where to find errors, pay

attention to these hints when debugging!

JavaVariablesO0.java

Code

public class JavaVariablesO {
public static void main(String[] args) {
int x;
System.out.printin("x = "+x);
}
}

Output

$ javac JavaVariables@.java
JavaVariables.java@:4: error: variable x might not have been initialized
System.out.println("x = "+x);

N

1 error

37



We must initialize local variables ourselves

JavaVariables01.java
Code

public class JavaVariablesO1 {
public static void main(String[] args) {
intx=75;
System.out.printin("x = "+x);
}
}

Output

$ javac JavaVariables01l.java
$ java JavaVariablesol
x =5

38



Initialization can happen after a variable is

declared

JavaVariables02.java
Code

public class JavaVariables02 {
public static void main(String[] args) {
int x;
X =5;
System.out.printin("x = "+x);

}
}

Output

$ javac JavaVariables02.java
$ java JavaVariables02
x =5

39



Variables can only hold the type of data

they were declared to hold

JavaVariables03.java
Code

public class JavaVariables03 {
public static void main(String[] args) {
int x;
x = "Hello world";
System.out.printin("x = "+x);

}
}

Output

$ javac JavaVariables@3.java
JavaVariables03.java:4: error: incompatible types: String cannot be converted
to int

x = "Hello world";

PaN

1 error

40



1. You, me, and this course

2. Object Oriented Programming (OOP)

3. Java intro
1. Hello world
2. Variables

» 3. Arrays
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We can use multiple variables to store

multiple values

MulitpleVariables.java
Code

public class MultipleVariables {
public static void main(String[] args) {
int scorel =5, score2 =7;
System.out.println(”scorel = "+ scorel + ", score2 =" + score2);

}
}

Output

$ javac MultipleVariables.java
$ java MultipleVariables
scorel = 5, score2 =7

42



Arrays provide a better way to store many

values in a contiguous block of memory

Code Index 0 1 2 3 4

public class MultipleVariablesArray { ‘ ‘ ‘ ‘
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8;
scores[5] = 9;
System.out.printin(scores);

43



Finding an index in an array is two math

operations: 1 addition and 1 multiplication

3

Code Index 0 1 2

public class MultipleVariablesArray { 10 ‘ 3.2 6.5

public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8;
scores[5] = 9;
System.out.printin(scores);

4

44



Java throws an exception if try to access

memory outside the contiguous block

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8; //valid indices are 0..4
scores[5]=9; //error, index out of bounds!
System.out.printin(scores);

}
}

Output

$ javac MultipleVariablesArray.java

S java MultipleVariablesArray

Exception in thread "main" java.lang.ArrayIndexOutOfBoundsException: Index 5
out of bounds for length 5

at MultipleVariablesArray.main(MultipleVariablesArray.java:9) "



Memory outside the contiguous block may

be used for other purposes

Code Index 0 1 2 3 4
public class MultipleVariablesArray { ? 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8 ?
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz’S'fores /
scores[0] = 10; //zero indexed in Java

scores[1] =3.2;

scores[2] = 6.5;

scores[3] =7.8;

scores[4] = 8.8; //valid indices are 0..4
scores[5]=9; //error, index out of bounds!
System.out.printin(scores);

}
}

Output

$ javac MultipleVariablesArray.java

S java MultipleVariablesArray

Exception in thread "main" java.lang.ArrayIndexOutOfBoundsException: Index 5
out of bounds for length 5

at MultipleVariablesArray.main(MultipleVariablesArray.java:9) "o



Printing an array prints the starting

memory address

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8; //valid indices are 0..4
//scores[5] =9; //error, index out of bounds!
System.out.printin(scores);

}
}

Output

$ javac MultipleVariablesArray.java
S java MultipleVariablesArray
[D@1dbd16a6
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One way to loop over array elements is to

use a C-style for loop

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
int numberOfScores = 5;
double[] scores = new double[numberOfScores]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8; //valid indices are 0..4
//scores[5] =9; //error, index out of bounds!

System.out.printin(scores); Output
NPT $ javac MultipleVariablesArray.java
System.out.print("["); $ java MultipleVariablesArray
for (int i= 0; i < numberOfScores-1; i++) { D@1dbd16a6
System.out.print(scores[i] + ", "); [10.0, 3.2, 6.5, 7.8, 8.8]
}

System.out.printin(scores[numberOfScores-1] + "]");
} 48



Java also has multidimensional arrays

Code MultidimensionalArray.java
public class MultidimensionalArray {
public static void main(String[] args) {
int numberOfStudents = 10;
int numberOfQuizes = 5;
double[][] scores = new double[numberOfStudents][numberOfQuizes];

//set score for student 3 on quiz 2
scores[2][1] = 9.2; //remember zero-indexing!

//print all scores

int quiz;

for (int student = 0; student < numberOfStudents; student++) {
for (quiz = 0; quiz < numberOfQuizes-1; quiz++) {

System.out.print(scores[student][quiz] + ", ");

}
System.out.printin(scores[student][quiz]);

}

}
}

49



Arrays holding numeric values are

initialized to zero

Code MultidimensionalArray.java

public class MultidimensionalArray {
public static void main(String[] args) {
int numberOfStudents = 10;
int numberOfQuizes = 5;
double[][] scores = new double[numberOfStudents][numberOfQuizes];

//set score for student 3 on quiz 2

scores[2][1] = 9.2; //remember zero-indexing! Output
$ javac MultidimensionalArray.java

. $ java MultidimensionalArray
//print all scores 0.0, 0.0, 0.0, 0.0, 0.0
Int quiz; 0.0, 0.0, 0.0, 0.0, 0.0
for (int student = 0; student < numberOfStudents; student++){8-g. 3-3. 8-8. 88. 8-8
for(qU|z=0;qU|.z<numberOmezes-l.;qU|z++){ 2.0, 0.0, 0.0, 0.0, 0.0
System.out.print(scores[student][quiz] + ", "); 0.0, 0.0, 0.0, 0.0, 0.0
} 0.0, 0.0, 0.0, 0.0, 0.0
. - 0.0, 0.0, 0.0, 0.0, 0.0
System.out.printin(scores[student][quiz]); 0.0, 0.0, 0.0, 0.0, 0.0
} 0.0, 0.0, 0.0, 0.0, 0.0

}

}
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Summary

* Syllabus: active learning, how to get help, honor code

* Object-oriented programming pillars
— Abstraction
— Encapsulation
— Inheritance
— Polymorphism
* Java intro:
— Hello world
— Variables with types
— Arrays
— Errors indicated at compile or run time
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* Encapsulation
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Additional Resources




CREATING HELLO WORLD



In keeping with tradition, we’ll start with

“Hello world”
HelloWorld.java

1. Start IntelliJ, create “cs10” Java Project (only need to do this one time)
2. Create “dayl1” Source folder to logically group your source code (e.g., “PS1” Source folder
holds all the source code for Problem Set 1)
3. Create new “HelloWorld” class in “day1” source folder
* File on disk is “HelloWorld.java”
 Class Name is “HelloWorld”
* Intelli) “stubs” out “main” method (where program execution starts)

Other items of note:

Javadoc
e Java documentation feature
* Enter description for Class or method
o Starts with “/**” ends with “*/”
e Can add tags such as “@author” or “@param”
main() is where action starts
Add System.out.printin(“Hello World”) to output to the console
Right click on code and choose “Run <class name>.main()” button to run
55



1. Create “cs10” Project to hold source

code (only need to do this one time)

Start Intelli), then select “Create new project” or click File->New->Project

1) Choose /

Java

New Project

ject SDK: | Pm 12 (java version "12.0.1") < New...

: Java Enterprise
i JBoss
J2ME
M Clouds
» Spring

= Java FX
' Android

IntelliJ Platform Plugin

& Spring Initializr
1 Maven
Gradle

& Groovy
Grails

Application Forge

Static Web
£ Flash

K Kotlin

= Empty Project

? Cancel

Additional Libraries and Frameworks:

i, JBoss
© Arquillian JUnit
© Arquillian TestNG
() JBoss Drools
& Java EE
- Web Application
@ Struts
@ struts 2

WebServices
o2 CDI: Contexts and Dependency Injection

Thymeleaf
|IE Conditional Comments support
Java 8 Time API compatibility
Spring 3 integration

P Snrina 4 intearation

Maven: org.thymeleaf.extras:thymeleaf-extras-java8time:RELEASE

Version: <
Download sources
Download JavaDocs

Download annotations

Include transitive dependencies Configure...

Previous

__ 2) Choose
Java
version

T~ 3) Take

defaults

4) Click
Next
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1. Create “cs10” Project to hold source

code (only need to do this one time)

Do not create project from template

Create project from template
Command Line App
aaaaaaaaaaaaaa

1) Leave
UNCHECKED

‘/////// 2) Click Next
57
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1. Create “cs10” Project to hold source

code (only need to do this one time)

Name project “cs10” and set directory on disk where code will be stored

@ o New Project

Project name: cs10

/ Project location: ~/Documents/IdeaProjects/cs10

1) Choose
Project name
(“cs10”)

v More Settings
Module name: cs10
Content root: /Users/tim/Documents/IdeaProjects/cs10
Module file location: /Users/tim/Documents/ldeaProjects/cs10

Project format: .idea (directory based)

? Cancel Previous

2) Choose
directory where
code will be
stored

3) Click Finish
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2. Create Source folder to hold your source

code for day one of class

Click File->New->Directory to create directory for related code (e.g., “dayl” or “PS1”)
2) Give directory a name

1) Click File->New->Directory

[ ] New Directory
\ ter new directory name:
@& InteliJ IDEA lGTW Edit View Navigate Code Analyze Refactor Build Run Tools VCS ! e
| ay
» .
Project...
& Open... Project from Existing Sources... | cancel | KT
Open URL... Project from Version Control... >
Open Recent » lor
Close Project Module... 7
Module from Existing Sources... * e 4 ’ gm—*iv?
B Project Structure... %8; " :aV‘ . ; ¥ Dertmodt
Other Settings > i File - - 1 d: . ow ¢ 7
=" Scratch File N’ X Cut X 2 :
. a1 Copy %C A
Export Settings... Copy Path 0 %C 1 b public sta
Settings Repository... i HTML File pu da g Copy Relative Path Y{}Zc yi i Systen
Sync Settings to JetBrains Account... 2 Stylesheet JEikeste N 14
Export Project to Eclipse... CFML/CFC file da Sng ps:gehs {;; 1 }
Export to Zip File... P da ind in Path...
i JavaScrlApt File da  Replace in Path... 0 #R
H Save All %S s TypeScript File } . . da  Analyze >
S Synchronize X8y| ® package.j§on File 3) R |g ht CI IC k da  Refactor >
Invalidate Caches / Restart... « Kotlin Script 33 Add to Favorites >
CoffeeScript File 91 o
o ‘A’ da  Show Image Thumbnails T®RT
B @ Gradle Kotlin DSL Build Script on ne E -
=R = o eforma ode
- @ Gradle Kotlin DSL Settings H da i e
Add to Favorites > d Optimize Imports X0
: & XSLT Stylesheet | reCto rV ga Delete... ®
a
Remove BOM Edit File Templates... then Select da  Build Module 'cs10'
da e
g Reveal in Finder
Line Separators > 11 Resource Bundle “ da & Open in Terminal
Make Directory Read-only & XML Configuration File > M a rk R g N
< lib ocal History
Diagram > :
Power Save Mode 9 . m Git ) >
[ R Data Source Dl re CtO ry - Synchronizeidayt
day24 ” z; 4% Compare With... %D
day27 New HTTP Request
;,\.Y...,. — g . a S a n d PS rk Dirry as » urs Root .
PS emove est Sources Root
o“ - P Resources Root
Source folders are a useful way to Sources = Diagams oY B o fasmiroes

] :
3 ©) Create Gist... Excluded

organize your code (ex. PS1 Source folder Root” DR T ke

SA 59
contains all code for Problem Set 1)
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3. Create new “HelloWorld” class in “day1”

source folder

Right click on Source folder and select New->Java Class

2) Give class a name (starting with capital letter)

& IntelliJIDEA File

Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help

e0e
2¢s10 B dayl

|
PR ERE R @ Heloworidien ®@ 0 Create New Class
a cs10 ~/Documents/ldeaProjects/cs10 1 /4K
.idea : Standard 'Hello Worlc Narne: Hellowo”d Tl
data 4 * @author Everyone who
B day1 = — S —
e =
T b isosCie Kind: | @ Class
, & Kotlin File/Class
@ Blol X Cut BX | 2 Fe
@ Blol 8 Copy #C | 2 scratch File ouN |
@Blol Copy Path o%C Package ] Cancel m
@Blol Copy Reference X{r3cC 2 EXML File W
@ slo| O Paste R |2 package-info.java
Z";e': Find Usages \CF7 | im module-info.java
el e
e Find in Pz«:nh... {38F HTML File
Y Replace in Path... OHRR | Stylesheet - . -
» 3) IntelliJ tes fil disk
e | > @ CRML/CFC fle ) ntelilJ creates riie on aisK (e.g.,
Refactor » s JavaScript File
e & TypeScript File «“ " I . ” I
+|® peckagenonrie HelloWorld.java”) and sets up your new class
:aV; Show Image Thumbnails 08T % Kotlin Script
o ffeeScript Fil
day9 Reformat Code BL Cofoase ol
R B um JavaFXApplication
day10 Optimize Imports Xo S L . . . § . . X
Delete. 100 =y 9 @ IntelliJIDEA File Edit View Navigate Co Analyze Refactor Build Run Tools VCS Window Help
day™1 @ Gradle Kotlin DSL Build Script
day12 Build Module 'cs10' © Gradle Kotlin DSL Settings ece
day13 Rebuild '<default>' {}38F9 | @ XSLT Stylesheet 2¢s10 ) B dayl ' @ HelloWorld
day14 =l " - v
day15 Reveal in Finder Edit File Templates... g Project v @ = & — © Helloworldjava
day16 B Open in Terminal GUI Form E = cs10 ~/Documents/ideaProjects/cs10 1 _ public class HelloWorld {
& A 2 3
day18 Local History > Create Dialog Class - fices 3 |
day19 Git S Form Snapshot cata
day21 S synchronize ‘day1" /i Resource Bundle day1
day22 @ XML Configuration File > © Blob
day23 4% Compare With... %D Diagram 5 & Blob0
~ : & 1
day24  open Module Settings %4 | & Google Guice Lo o :o:gz
day27  Mark Directory as > Data Source S
inputs Remove BOM & BlobDriver
libs = #m New HTTP Request & BlobDriver2
mazes 1 Diagrams > T @ HelloWorld
& HellaWarldWith lavaDae

1) Right click on Source folder (e.g. “dayl1”),
then select New->Java Class 60



Intelli) creates HelloWorld.java

“boilerplate” code

@ IntelliJIDEA File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
| NON )

= €s10 = Bm dayl = @ HelloWorld

Project = € = B — © Helloworld.java

% €10 ~/Documents/IldeaProjects/cs10 : public class Helloworld {
.idea A I}
data ’

I 1: Project |

iav; ) File on disk is HelloWorld.java

& Blob0 Class is named HelloWorld
€ Blob01

& Blob02

& BlobDriver

& BlobDriver2

© HelloWorld
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We can flesh out the boilerplate code to

print “Hello World!” to the console

Execution begins at main() method
Type “main” then enter and Intelli)J expands to include the main method declaration

public clasyﬁ(orld { public class Hello

mair| . : . . :
} I i e T aT public static void main(String[] args) {

Press ~. to choose the selected (or first) suggestion and insert a dot afterwards >>

b

In Java a print statement is System.out.printin(“text you want to print goes here”);
Type “sout” then enter to have IntelliJ fill out print statement for you (saves a lot of typing!)

public class/HelloWorld {
publicfStatic void main(String[] args) {
souf]
S0UT Prints a string to System.ou_
} soutm

soutp
Soutv

~ public class HelloWorld {
public static void main(String[] args) {
System.out.printinf]);

Press ~. to choose the selected (or first) suggestion and insert a dot afterwards >> n
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We can flesh out the boilerplate code to

print “Hello World!” to the console

/:f:;fl
# Standard 'Hello World' first program
- 4
* @author Everyone who has ever written about programming and Tim Pierson too,

* Dartmouth Fall 2018 \ Javadoc

%/ * Describes program (or method)
* Begins with “/**” ends with “*/”

public class HelloWorld {
public static void main(Stringl[] args) {
System.out.printin("Hello World!"); Add tags such as

“@author” or “@param”
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Running the program prints “Hello World!”

to console

a €s10 ~/Documents/IideaProjects/cs10 1 /%K

idea 2 * Standard 'Hello World' first program
3 %
data 4 * @author Everyone who has ever written about programming and Tim Pierson too,
day1 5 * Dartmouth CS 10, Fall 2018
© Blob = o Copy Reference X(%C
::B|°b° & » _ public class HelloWorld { O Paste BV . . .
9 b ublic static void main(Strin args
oeion - PRl Run program by right clicking
& BlobDriver 12 } Column Selection Mode 988 °
@ oisorners ) on program text and selecting
@ HelloWorld s Reiactoy ¢
@ HelloWorldWithJavaDoc o5 Foldin a“ R I H 14
& WebcamTest Analyzge > un <c ass name>-maln()
day2
day3 Go To >
day4 Generate... #EN
days Recompile 'HelloWorld.j3&' 0 3F9
day6 Run 'Helloworld.main()*
day7 # Debug 'HelloWorld.main()' AQD
day8 U Run 'HelloWorld.main()' with Coverage
day9 y P~
day10 Save 'HelloWorld.main()
day11 Reveal in Finder
day12 B Open in Terminal
day13 '
day14 Lc_>ca| History >
day15 Git >
day16 [3 Compare with Clipboard
day18 File Encoding
day19 A
day21 i3 Dlagrams_, >
day22 ©) Create Gist...
day23 WebServices >
day24
day27
inputs °
Output appears in console below
mazeSearch
out
pictures
PS-1
PS-2
PS-3
PS-4
PS-5
PS-6
SA-1
cA.n
un: SketchServer
|- /Library/Java/, alMachines/jdk-12.0.1.jdk/Contents/Home/bin/java "-javaagent:/Applications/Intelli) IDEA.app/Contents/lib/idea_rt.ja

Hello World!
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Process finished with exit code @
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Variables — Python example

ANNOTATED SLIDES



In Python we declare variables but do not

say what type of data they hold

Python example python_variables0.py
Code
print(x) Variable x is not defined, Python has no idea

what to print and gives an error message

Output

S python3 python_variables0.py

Traceback (most recent call last):
File "PythonVariables.py", line 2, in <module>
print(x)
NameError: name ‘X' is not defined
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In Python we declare variables but do not

say what type of data they hold

Python example python_variables01.py
Code
X =5 Give a value to x and Python prints is value
print(x)

Note: you didn’t tell Python what type of data
x holds, just its value

Python guesses x is an integer based on the
value assigned (called dynamic or duck typing)

Output

S python3 python_variables01.py

5
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Python’s type function tells us what kind of

data the variable holds

Python example python_variables02.py
Code

X =5 Confirm Python thinks variable x is an
print(x) integer by printing its data type

print(type(x))

Confirmed, Python thinks x is an integer

Output

S python3 python_variables02.py
5

<class 'int'>

68



In Python a variable’s data type can change

Python example python_variables03.py
Code

X =5 Python allows the type of a variable to change
print(x)

print(type(x)) Still guesses variable type based on value assigned
x = "Hello World"

print(x) Now thinks x is a String

print(type(x))

Output

S python3 python_variables03.py
5

<class 'int'>
Hello World
<class 'str'>
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In Python a variable’s data type can change

Python example python_variables03.py
Code

X =5 Python allows the type of a variable to change
print(x)

print(type(x)) Still guesses variable type based on value assigned
x = "Hello World"

print(x) Now thinks x is a String

print(type(x)) Unlike Python we will tell Java
specifically what kind of data
a variable holds

Output . .
P Once we give a variable a

S python3 python_yariables03.py type, we can’t change it to a
5 different type later (e.g., an

<class 'int'> integer can’t become a String
Hello World in Java)

<class 'str'>
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Variables — Java example

ANNOTATED SLIDES



In Java, we explicitly say what type of data

a variable holds (and can’t change it!)

JavaVariablesO0.java

Code

public class JavaVariablesO {
public static void main(String[] args) { Java knows x is an integer because

intx; <€— we declare it as an integer
System.out.printin("x = "+x);
} When a variable is declared Java
} allocates memory for it

Here Java allocates memory for

one integer (4 bytes)
Output

72



Java does not initialize local variables

JavaVariablesO0.java
Code

public class JavaVariablesO {
public static void main(String[] args) { This code looks like it should run,

int x; but fails at compile time
System.out.printin("x = "+x);
} Why?
}
X is not given an initial value
It was also an error in Python
Output

when we didn’t give x a value

$ javac JavaVariables. java

JavaVariables@.java:4: error: variable x might not have been initialized
System.out.println("x = "+x);

N

1 error
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Java tells us where to find errors, pay

attention to these hints when debugging!

JavaVariablesO0.java

Code

public class JavaVariablesO {
public static void main(String[] args) { Note: Java tells us what file
int x; contained the error

System.out.printIn("x = "+x);

And also tells us what line number!

}
}

Output

$ javac JavaVarjidblesQ/java
JavaVariables.java@:4: error: variable x might not have been initialized
System.out.println("x = "+x);

N

1 error
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We must initialize local variables ourselves

JavaVariables01.java
Code

public class JavaVariablesO1 {

public static void main(String[] args) { o ) ]
Initialize x with an integer value

intx=5;, e
System.out.printin("x = "+x);
}
} Note: javac from the command line

compiles file name provided

Creates a file with a .class extension with
Output the byte code (JavaVariables.class here)
$ javac JavaVariables@l. java

$ java JavaVariables0l
X =15

\ java command runs the byte code (no need to
provide the .class file extension)
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Initialization can happen after a variable is

declared

JavaVariables02.java
Code

public class JavaVariables02 {

public static void main(String[] args) { ) ]
Not necessary to give local variables

int x; _
X=5; €— a value when declared
System.out.printin("x = "+x);
) Just give the variable a value before
} using it
Output

$ javac JavaVariables02.java
$ java JavaVariables02
x =5

76



Variables can only hold the type of data

they were declared to hold

JavaVariables03.java
Code

public class JavaVariables03 {

public static void main(String[] args) { ]
Variables must hold the type of data

int x;
x = "Hello world"; / they were declared to hold

System.out.printin("x = "+x); o
) Here we can’t store a String in an

) integer variable!

Java tells us where to find the error
(file name: line number)

Output

$ javac JavaVariables0
JavaVariables03.java:4:
to int

error: incompatible types: String cannot be converted
x = "Hello world";

PaN

1 error
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Arrays

ANNOTATED SLIDES



We can use multiple variables to store

multiple values

MulitpleVariables.java

Code
_ Say we wanted to track multiple quiz scores
public class MultipleVariables {
public static void main(Strincha“ declare multiple variables on one line
int scorel =5, score2 =7;
System.out.println(”scorel = "+ scorel + ", score2 =" + score2);
}
} Here both scorel and score2 are integers,
initialized with different values
This approach becomes cumbersome if we
Output want to track many values

$ javac MultipleVariables.java
$ java MultipleVariables
scorel = 5, score2 =7
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Arrays provide a better way to store many

values in a contiguous block of memory

Code Index 0 1 2 3 4

public class MultipleVariablesArray { ‘ ‘ ‘ ‘
public static void main(String[] args) {
double[] scores = new doubl store quiz scores
scores[0] = 10; //zero indexed Tn Zﬁ Use an array to store multiple quiz scores
scores[1] =3.2;
scores[2] = 6.5;
scores[3] = 7.8; Here enough room to hold 5 doubles

scores[4] = 8.8; //valid indices are 0.4 (5 doubles * 8 bytes/double = 40 bytes)
scores[5]=9; //error, index out of bounds!
System.out.printin(scores); Arrays are zero-indexed in Java (unlike Matlab)

OS allocates a contiguous block of memory

Keyword new allocates memory for array (we
will see soon this is an object)

scores holds the starting address of contiguous
memory block
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Finding an index in an array is two math

operations: 1 addition and 1 multiplication

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 6.5 ‘
public static void main(String[] args) {

double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5; €
scores[3] =7.8;
scores[4] = 8.8; //valid indices are 0..4
scores[5]=9; //error, index out of bounds!
System.out.printin(scores);

~ Access values the array holds by telling
Java which index to use

Java gets address:
starting address + index * size of values

Here index 2 is at starting address of
) scores array + 2 * 8 bytes/double (16

bytes offset from start)

Can find the first element in same time it
takes to find the last element
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Java throws an exception if try to access

memory outside the contiguous block

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores

scores[0] = 10; //zero indexed in Java
scores[1] =3.2; Java throws an exception if you try to

scores[2] = 6.5; access an element before or after the
scores[3] =7.8; array’s block of memory

scores[4] = 8.8; //vakeTndices are 0..4
scores[5] =9; €//error, index out of bounds!
System.out.printin(scores);

}
}

Output

$ javac MultipleVariablesArray.java

S java MultipleVariablesArray

Exception in thread "main" java.lang.ArrayIndexOutOfBoundsException: Index 5
out of bounds for length 5

at MultipleVariablesArray.main(MultipleVariablesArray.java:9)
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Memory outside the contiguous block may

be used for other purposes

Code Index O 1 2 3 4
public class MultipleVariablesArray { ? 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8 ?
public static void main(String[] args) {

double[] scores = new double[5]; //store quiz’S'{ores /
scores[0] = 10; //zero indexed in Java
scores[1] = 3.2; Can you assume the memory before or
scores[2] = 6.5; after the allocated block is available for
scores[3] =7.8; your use?

scores[4] = 8.8; //valid indices are 0..4
scores[5] =9; //error, index out of bounds! NO! The OS allocated the block of

System.out.printin(scores); memory for the array and may be using
} the memory before or after for other
} purposes!
Output

C programmers can access memory

$ javac MultipleVariablesArray.java before or after, this often causes bugs!
S java MultipleVariablesArray

Exception in thread "main" java.lang.ArrayIndexOutOfBoundsException: Index 5
out of bounds for length 5

at MultipleVariablesArray.main(MultipleVariablesArray.java:9) “



Printing an array prints the starting

memory address

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8; //valid indices are 0..4
//scores[5] =9; //error, index out of bounds!
System.out.printin(scores); €—

}
}

Output

$ javac MultipleVapidablesArray.java
S java Multipl riablesArray
[D@1dbd16a6

By default, printing an array prints a value
based on the array’s starting memory address
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One way to loop over array elements is to

use a C-style for loop

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {

int numberOfScores = 5;
double([] scores = new doubléfrumberOfScores]; //store quiz scores
scores[0] = 10; //zero indexed in Ja

scores[1] = 3.2; Normally use a variable to declare array size

scores[2] = 6.5; C-style for loop
scores[3] =7.8; Three components:
scores[4] = 8.8; //valid indices are 0..4 1. Initialization
//scores[5] =9; //error, index out of bounds 2. Conditional
System.out.println(scores); 3. Increment

Output

NPT $ javac MultipleVariablesArray.java
System.out.print("["); $ java MultipleVariablesArray
for (int i= 0; i < numberOfScores-1; i++) { D@1dbd16a6

System.out.print(scores[i] + ", "); [10.0, 3.2, 6.5, 7.8, 8.8]
}

System.out.printin(scores[numberOfScores-1] + "]");
} 85



One way to loop over array elements is to

use a C-style for loop

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
int numberOfScores = 5;
double[] scores = new double[numberOfScores]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5; Access elements at index i using
scores[3] =7.8; square brackets
scores[4] = 8.8; //valid indices are 0..4
//scores[5] =9; //error, index out of bounds!
System.out.printin(scores);

Note: using print not printin here

Output printin adds a new line character

NPT $ javac MultipleVariablesArray.java
System.out.print("["); $ java MultipleVariablesArray
for (int i= 0; i < numberOfScores-1; i++) { D@1dbd16a6

System.out.print(scores[i] + ", "); [10.0, 3.2, 6.5, 7.8, 8.8]
}

System.out.printin(scores[numberOfScores-1] + "]");
} 86



Java also has multidimensional arrays

Code MultidimensionalArray.java

public class MultidimensionalArray { Store qu'? scor(.es for f,everal
public static void main(String[] args) { students in 2-dimensional array

int numberOfStudents = 10; One row for each student

int numberOfQuizes = 5; One column for each quiz
double scores[][] = new double[numberOfStudents][numberOfQuizes];

__ Remember zero indexing!
Student 3 is at index 2
Quiz 2 is at index 1

//set score for student 3 on quiz 2
scores[2][1] = 9.2; FFemember zero-indexing!

//print all scores
int quiz; «— Can declare variable outside for loop so its scope goes beyond for loop

for (int student = 0; student < numberOfStudents; student++) {
for (quiz = 0; quiz < numberOfQuizes-1; quiz++) {

System.out.print(scores[student][quiz] + ", "); = Nested loops

} Loop over each student
System.out.printin(scores[student][quiz]); loop over each quiz
} /1 print quiz score for student
}
} Because quiz declared outside for loop, it is still in scope

here (would be out of scope if declared as part of for loop) 87



Arrays holding numeric values are

initialized to zero

Code MultidimensionalArray.java
public class MultidimensionalArray { Java initializes numeric
public static void main(String[] args) { array values to zero

int numberOfStudents = 10;
int numberOfQuizes = 5;
double scores[][] = new double[numberOfStudents][numberOfQuizes];

//set score for student 3 on quiz 2

scores[2][1] = 9.2; //remember zero-indexing! Output
<\ $ javac MultidijmensionalArray.java
Jprint all Value set $ java MultidigensionalArray
//Print ait scores 0.0, 0.0, 0.0,0.0, 0.0
Int quiz; 9, 0.0, 0.0, 0.0, 0.0
for (int student = 0; student < numberOfStudents; student++) { 2.9 9.2, 0.0, 0.0, 0.0
for (quiz = 0; quiz < numberOfQuizes-1; quiz++) { gg' 8'8' 8'8' gg' 8'8
System.out.print(scores[student][quiz] + ", "); 0.0, 0.0, 0.0, 0.0, 0.0
} 0.0, 0.0, 0.0, 0.0, 0.0
. - 0.0, 0.0, 0.0, 0.0, 0.0
System.out.printin(scores[student][quiz]); 0.0, 0.0, 0.0, 0.0, 0.0
} 0.0, 0.0, 0.0, 0.0, 0.0
}

}
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